
    Novell Confidential                                                                                            Manual (ENU)  6 October 2004
GroupWise 6.5 
Support Pack 3
November 30, 2004

Overview
The information in this Readme file pertains to Novell® GroupWise® 6.5 Support Pack 3. This 
Support Pack contains updates for all components contained in the GroupWise 6.5 product. 
However, this Support Pack does not contain updates for GroupWise Messenger. GroupWise 
Messenger 1.0 Support Pack 3 is a separate download.

GroupWise 6.5 Support Pack 3 combines the NetWare®, Linux*, and Windows* GroupWise 6.5 
software into a single Support Pack. The NetWare and Windows software is provided in one set 
of downloads; the Linux software, including the Cross-Platform client for Linux and Macintosh*, 
is provided in a separate set of downloads. 

For information on the latest Support Pack issues, see the GroupWise 6.5 Support Pack 3 Readme 
Addendum (http://support.novell.com/cgi-bin/search/searchtid.cgi?/10093964.htm).

1.0  NetWare/Windows: Support Pack Installation

1.1  GroupWise Version Information
GroupWise 6.5 Support Pack 3 can be applied to the following GroupWise versions in your 
software distribution directory on NetWare or Windows:

GroupWise 6.5 (original version)

GroupWise 6.5.1 (Support Pack 1)

GroupWise 6.5.2 (Support Pack 2)

When you update the software distribution directory, all GroupWise components must be updated 
to keep them at the same version level.

1.2  Prerequisites
Before installing GroupWise 6.5 Support Pack 3:

Ensure that the network login account used to apply the Support Pack has Read, Write, Create, 
and Erase rights to the GroupWise software distribution directory.

Ensure that users do not access the software distribution directory during the update process.

Verify that the GroupWise software distribution directory and files are not flagged Read-
Only.
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1.3  Downloading and Installing the NetWare/Windows Support Pack
GroupWise 6.5 Support Pack 3 is available as two self-extracting (.exe) files, one for 
administrative files and one for Windows client files. English-only and multilingual versions are 
available. You can download the Support Pack from the GroupWise 6.5 Product Updates page 
(http://support.novell.com/filefinder/16963/index.html).

1.3.1  Downloading the Installing the Administration Software

1 From the list of Support Packs, download GroupWise 6.5 Admin SP3 (gw653e.exe for 
English only or gw653m.exe for multilingual) into a temporary directory.

2 Extract the .exe file into a directory at the root of your local drive or to a network server drive 
that can handle long pathnames.

The compressed file contains directory paths that could exceed DOS limits. 

3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the 
Support Pack files.

4 Select the setup.exe file, then click OK to run the GroupWise Installation Advisor.

5 Click Create or Update a GroupWise system.

6 Follow the on-screen instructions provided in the GroupWise Installation Advisor to update 
the software distribution directory and the administration, agent, and client software that is in 
production.

7 After applying the Support Pack on NetWare servers where GroupWise agents are running, 
restart the servers to ensure that all updated NLMTM programs are loaded.

This resolves any errors you might see during the update process.

For complete installation instructions, see the GroupWise 6.5 Installation Guide at the GroupWise 
6.5 Documentation Web site (http://www.novell.com/documentation/gw65).

1.3.2  Downloading and Installing the Windows Client Software

1 From the list of Support Packs, download GroupWise 6.5 Client SP3 (gw653ce.exe for 
English only or gw653cm.exe for multilingual) into a temporary directory on your 
workstation.

2 Extract the .exe file into a directory at the root of your local drive.

The compressed file contains directory paths that could exceed DOS limits. 

3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the 
Support Pack files.

4 Select the setup.exe file, then click OK to run the GroupWise client Setup program.

5 Follow the on-screen instructions provided in the GroupWise client Setup program to update 
the client software on your workstation.

For complete installation instructions, see the GroupWise 6.5 Installation Guide at the GroupWise 
6.5 Documentation Web site (http://www.novell.com/documentation/gw65).
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2.0  Linux: Support Pack Installation

2.1  GroupWise Version Information
GroupWise 6.5 for Linux Support Pack 3 can be applied to the following GroupWise versions in 
your software distribution directory:

GroupWise 6.5 for Linux (original version)

GroupWise 6.5.2 for Linux (Support Pack 2)

The GroupWise 6.5 for Linux software distribution directory must already exist in order to install 
Support Pack 3. When you update the software distribution directory, all GroupWise components 
must be updated to keep them at the same version level.

2.2  Downloading and Installing the Linux Support Pack
GroupWise 6.5 for Linux Support Pack 3 is available as compressed tar files, one for the 
GroupWise administration software, one for the Cross-Platform client for Linux, and one for the 
Cross-Platform client for Macintosh. All languages are included. You can download the Support 
Pack from the GroupWise 6.5 Product Updates page (http://support.novell.com/filefinder/16963/
index.html).

2.2.1  Downloading and Installing the Administration Software

The administration software includes the GroupWise agents and the GroupWise Administrator 
snap-in to ConsoleOne®.

1 Download the compressed tar file (gw653lnx.tar.gz) to a temporary directory on your Linux 
server.

2 In a terminal window at your Linux server, change to the temporary directory, then use the 
following commands to uncompress and untar the downloaded file:

gzip -d gw653lnx.tar.gz
tar -xvf gw653lnx.tar

The result is a directory named gw653lnx.

3 Change to the gw653lnx directory.

4 Enter the following command:

xhost + localhost

5 In the same window, become root by entering su and the root password.

6 Start the GroupWise Installation Advisor:

./install

7 Click Create or Update a GroupWise System.

8 Follow the on-screen instructions to update the software distribution directory and the 
administration and agent software that is in production.

For complete installation instructions, see the GroupWise 6.5 Installation Guide at the GroupWise 
6.5 Documentation Web site (http://www.novell.com/documentation/gw65).
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2.2.2  Downloading and Installing the Cross-Platform Client for Linux

1 Download the compressed tar file (gw653clnx.tar.gz) to a temporary directory on your Linux 
workstation.

2 In a terminal window at your Linux workstation, change to the temporary directory, then use 
the following commands to uncompress and untar the downloaded file:

gzip -d gw653clnx.tar.gz
tar -xvf gw653clnx.tar

The result is a directory named gw653clnx.

3 Change to the gw653clnx directory.

4 Run the GroupWise Setup Advisor to install the GroupWise Cross-Platform client software:

./install

5 To start the Cross-Platform client after installation, click the GroupWise icon on your Linux 
desktop.

For complete installation instructions, see the GroupWise 6.5 Installation Guide at the GroupWise 
6.5 Documentation Web site (http://www.novell.com/documentation/gw65).

2.2.3  Downloading and Installing the Cross-Platform Client for Macintosh

1 Download the StuffIt file (gw653cmac.sit) to a temporary directory on your Macintosh 
workstation.

2 At your Macintosh workstation, browse to the gw653cmac.sit file.

3 Double-click the gw653cmac.sit file to uncompress the downloaded file.

The result is a directory named gw653cmac.

4 Change to the gw653cmac directory.

5 Double-click the GroupWise.app.sit file to install the GroupWise Cross-Platform client 
software.

6 To start the Cross-Platform client after installation, click the GroupWise icon on your 
Macintosh desktop.

For complete installation instructions, see the GroupWise 6.5 Installation Guide at the GroupWise 
6.5 Documentation Web site (http://www.novell.com/documentation/gw65).

3.0  Installation Issues

3.1  General Installation Issues

3.1.1  WebAccess and Monitor on the Same Web Server

The WebAccess Application, WebPublisher Application, and Monitor Application share a 
common library. If you plan to run these applications on the same Web server, you must update 
all three before any of them can work properly.
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3.1.2  Wireless Device Support for WebAccess and Monitor

The GroupWise® WebAccess and Monitor software included in GroupWise 6.5 Support Pack 3 
supports the following wireless devices:

WAP-enabled wireless devices that use HDML 3 or WML 1.1 compatible microbrowsers

Palm OS* devices

We are continually evaluating and adding support. As we add support for additional devices, we 
post the updates on the Novell GroupWise Wireless page (http://www.novell.com/wireless). We 
encourage you to check this site frequently for updates and news.

3.1.3  Additional Installation Issues

Platform-specific installation issues are listed in separate sections below. Installation issues for 
individual GroupWise components are located under the heading for each component.

3.2  NetWare/Windows Installation Issues

3.2.1  Recommendation for Overwriting Newer Files

When the gwpo.dc and ngwguard.dc files from the original Novell® GroupWise 6.5 release are 
installed, they receive the date and time when they are installed rather than retaining their original 
date and time. As a result, they might have a newer date and time than the ngwguard.dc files in 
Support Pack 3. If they do, you receive the following message:

“The files you are installing are older than the files on your system. Do you want to replace these 
files?”

Typically you should respond No to such a prompt, but in this case you should respond Yes so that 
the Support Pack version of the .dc files is installed. If necessary, you can manually copy these 
files from the original GroupWise 6.5 Administration CD to the corresponding location in the 
software distribution directory:

\po\ngwguard.dc
\client\win32\ngwguard.dc

You might also see this message if you are installing GroupWise 6.5 Support Pack 3 as an update 
to GroupWise 6 where Support Pack 3 or later has been installed. Again, respond Yes to overwrite 
newer files.

As an alternative, you can create a new software distribution directory for the GroupWise 6.5 
Support Pack 3 files.

3.2.2  Problem Installing from a Windows XP Service Pack 2 Machine

When installing any GroupWise agent (Post Office Agent, Message Transfer Agent, Internet 
Agent, WebAccess Agent, Monitor Agent) to a NetWare® server from a Windows* XP machine 
where Service Pack 2 has been installed, you must have the Novell ClientTM 4.90 SP2 or later 
installed on the Windows machine. If you have an earlier Novell Client, the GroupWise 
Installation Advisor claims that it cannot find some of the directories to which you want to install 
software.
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3.2.3  Windows 2000 Service Pack 2 or Later Required for Agents

If the GroupWise Post Office Agent, Message Transfer Agent, Internet Agent, and WebAccess 
Agent are installed on Windows 2000 and the GroupWise domain and/or post office directories 
accessed by the agents are on NetWare servers, you need to apply Windows 2000 Service Pack 2 
or later on the Windows servers. You can download Windows 2000 Service Packs from Microsoft* 
(http://windowsupdate.microsoft.com).
NOTE: If, as required with the initial release of GroupWise 6, you already installed Microsoft HotFix Q266066 
on all Windows 2000 servers where GroupWise agents run, you do not need to apply Windows 2000 Service 
Pack 2 or later.

3.2.4  GroupWise Version Compatibility

If you still have GroupWise 4.1 domains or post offices in your GroupWise system, you must 
update them to at least GroupWise 5.2 before updating your primary domain to GroupWise 6.5. If 
you try to update a 4.1 domain or post office to 6.5 after the primary domain has already been 
updated to 6.5, you need to rebuild each 4.1 secondary domain database using the GroupWise 6.5 
Support Pack 3 snap-ins to ConsoleOne®, and you also need to have each rebuilt secondary 
domain database manually edited by Novell Support before it will function correctly with the 6.5 
primary domain. 

3.3  Linux Installation Issues

3.3.1  SUSE LINUX Enterprise Server 9

The GroupWise agents are now supported on SUSE® LINUX Enterprise Server (SLES) 9. 

You can also run ConsoleOne on SLES 9 with the proper preparation. 

If ConsoleOne is already installed and you are running Novell eDirectoryTM 8.7.3 or earlier, make 
sure that you install the GroupWise Administrator snap-in to ConsoleOne before you try to run 
ConsoleOne. This installation updates the version of the JRE to the required version.

If you need to install ConsoleOne on a server where you are running an eDirectory version later 
than 8.7.3, you need to make a simple modification to the installation script. 

1 After downloading ConsoleOne and untarring it, change to the Linux directory.

2 Edit the c1-install script.

3 Locate the nds_version line.

4 Change 8.7.3 to the version of eDirectory that you are running (for example, 8.7.3.2 or 
8.7.3.3).

5 Save and exit the file, then run the script to install ConsoleOne.

6 Install the GroupWise Administrator snap-in to ConsoleOne.

3.3.2  Multiple Agents on the Same Server

After you have installed the GroupWise 6.5 for Linux Support Pack 3 versions of the POA and the 
MTA, any existing Internet Agent, WebAccess Agent, or Monitor Agent installed on the same 
server no longer runs. You must update all agents on the same server to GroupWise 6.5 for Linux 
Support Pack 3 in order for the agents to run correctly.
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3.3.3  Moving a GroupWise 4.1 System from NetWare or Windows to Linux

The Update section of the GroupWise 6.5 Installation Guide provides instructions for moving 
from NetWare or Windows to Linux*. If you are moving post offices and domains belonging to a 
GroupWise 4.1 system, you might need to manually rename the domain database (wpdomain.db) 
from uppercase to lowercase, along with all .dc files. In addition, subdirectories in post office and 
domain directories might need to be renamed to lowercase.

4.0  Administration Issues

4.1  General Administration Issues

4.1.1  Server Names

When filling in a UNC Path field in ConsoleOne, you must specify the server name. You cannot 
use an IP address or DNS hostname.

4.1.2  Server-Based Anti-Virus Software

If you run server-based anti-virus software, you should configure it so that it does not scan 
GroupWise directory structures such as domains and post offices where file locking conflicts can 
create problems for the GroupWise agents. If you need virus scanning on GroupWise data, check 
the GroupWise Partner Products page (http://www.novell.com/partnerguide/p100031.html) for 
compatible products.

4.2  NetWare/Windows Administration Issues

4.2.1  Directory Names and Filenames

All directory names in paths to GroupWise domains and post offices can consist of up to 8 
characters. 

Filenames can also consist of up to 8 characters, with extensions of up to 3 characters. Do not use 
long filenames for any files used by any GroupWise components. This requirement applies even 
to files that are not specific to GroupWise (such as SSL certificates and key files).

4.2.2  ConsoleOne on Windows NT 

If you will run ConsoleOne on Windows NT* 4, you must install NT 4 Service Pack 6 before you 
install ConsoleOne.

4.2.3  GWTSA and Duplicate Source Directories

GWTSA handles situations where the same directory names are used on different volumes to back 
up by numbering the instances. For example:

Original GWTSA
GroupWise System/[Dom]Provo2:
GroupWise System/[Dom]Provo2:

Support Pack GWTSA
GroupWise System/1[DOM]Provo2:
GroupWise System/2[DOM]Provo2:
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Each instance is numbered and DOM is in all uppercase letters. After updating GWTSA with 
Support Pack 1 or later, you must re-create your backup jobs because the path has changed.

4.2.4  Quotas on NSS Volumes

If you use NSS volumes with quotas turned on, then you must turn on quotas on all GroupWise 
directories. Otherwise, you will receive No Disk Space errors.

4.2.5  TurboFat Compatibility

If you see E811 errors on the POA or the GroupWise client, a possible cause is that TurboFat is 
corrupting GroupWise database pointers. The solution is to turn off TurboFat.

To turn off TurboFat on NetWare 5.x servers, use turbodis.nlm.

To turn off TurboFat on NetWare 6.x servers, use tdis600.nlm.

These NLMTM programs disable TurboFat at startup.

4.3  Linux Administration Issues

4.3.1  NFS Not Supported

Because of long-standing file lock issues with NFS, you cannot use an NFS mount to mount a 
server file system where your GroupWise system is located to a workstation where you are running 
ConsoleOne. We recommend using an SMB mount instead.

4.3.2  Pathnames and Filenames in Lowercase

All directory names in paths to GroupWise domains and post offices should consist of lowercase 
letters. Filenames should also consist of lowercase letters. There are no length restrictions.

However, if you update a GroupWise 4.1 system and move it to Linux, you might see uppercase 
letters in database names. This is not a problem. The Database Copy (DBCopy) utility that you use 
to move domains and post office to Linux handles any uppercase/lowercase issues that might arise, 
so you should not manually rename any databases that have been copied to Linux using DBCopy.

4.3.3  UNC Paths in ConsoleOne

On Linux, ConsoleOne translates UNC paths into Linux paths.

4.3.4  Display Problem with ConsoleOne Property Page Tabs

If you run ConsoleOne on SUSE LINUX 9 with Ximian® Desktop 2 installed, the label text on the 
property tabs does not display. As a workaround, click the tab to select it, then use the Up-arrow 
and Down-arrow keys to display each property page until you reach the one you want.

4.3.5  Unavailable Administration Features

GroupWise 6.5 for Linux does not include the following administration features that are available 
in GroupWise 6.5:

Import/Export utility in ConsoleOne

Document Properties Management feature in ConsoleOne
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5.0  Agent Issues

5.1  General Agent Issues

5.1.1  POA Redirection Enhancement

You can now configure the POA to control where users are redirected, regardless of where users 
are located. In the past, a POA configured with both an internal IP address and a proxy IP address 
automatically redirected internal users to internal IP addresses and external users to external IP 
addresses. Now, you can configure two POA objects for a post office, one with only an internal IP 
address and one with only a proxy IP address. GroupWise clients that access the internal IP address 
are redirected internally, no matter where the users are located. Clients that access the proxy IP 
address are redirected externally, no matter where the users are located. This overrides the POA’s 
built-in capability of detecting where users are logging in from and redirecting them accordingly. 

For setup instructions, see Controlling Client Redirection Inside and Outside Your Firewall in Post 
Office Agent in the GroupWise 6.5 Administration Guide.

5.2  NetWare/Windows Agent Issues

5.2.1  POA Slows Down

If you are running the POA on NetWare 6.0 Support Pack 2 on a multiprocessor such as a Dell* 
6650 PowerEdge* or an IBM* Netfinity*, the POA might gradually slow down after a few hours 
or a day, depending on its load. GroupWise client users could also experience extremely slow 
response time from the POA. Update from NetWare 6.0 Support Pack 2 to Support Pack 3.

5.2.2  Potential CAP Port Conflict

By default, the POA uses 1026 for its CAP (Calendar Access Protocol) port. On some Windows 
2000 servers, port 1026 is already used the Windows Task Scheduler or other Windows service. 
If this occurs, configure the POA to use a different CAP port in ConsoleOne.

5.3  Linux Agent Issues

5.3.1  libXm.so.3 Error

If you try to start the POA or MTA on a server where The X Window System* and OpenMotif are 
not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and OpenMotif before starting the POA or MTA 
with the --show switch. If you start the POA or MTA without the --show switch, you can use the 
agent’s Web console to monitor the agent from your Web browser.
9
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6.0  Client Issues

6.1  Windows Client Issues

6.1.1  Windows XP Service Pack 2

Installing Windows XP Service Pack 2 enables the Windows Firewall by default. The default 
Windows Firewall configuration blocks UDP (User Datagram Protocol). GroupWise is dependent 
on UDP for several key features such as listing new messages in your Mailbox, displaying 
notifications, and performing Busy Searches. To reconfigure the Windows Firewall so that it does 
not interfere with GroupWise functionality, follow the instructions in TID 10094089 in the Novell 
Support Knowledgebase (http://support.novell.com/search/kb_index.jsp).

6.1.2  New JAWS Script Available

Users of the JAWS screen reader should install the new JAWS script available in GroupWise 6.5 
Support Pack 3. Copy the groupwise.jsb file from the \client\jaws directory of the Support Pack to 
the \jaws510\settings\enu directory on your workstation. This JAWS script is necessary in order 
to take advantage of many of the Section 508 accessibility fixes in this Support Pack.

6.1.3  NetWare 5.1 SP1 Compatibility for Client Installation

If you are using the AutoUpdate feature for installing the GroupWise 6.5 client, you might 
encounter an error if you are installing the client from a NetWare 5.1 server where a Support Pack 
has been installed. The setupip.exe program used during the AutoUpdate process might not run 
correctly.

To resolve the problem, you must modify the magnus.conf file located in the following directory:

sys:\novonyx\suitespot\http-web_server_name\config 

by adding the following line:

MaximumFilesReturnedInIndex 500

Then run the client installation again.

6.2  Cross-Platform Client Issues

6.2.1  Linux Client Installation on Red Hat 8

On Red Hat* 8, you cannot use the main GroupWise Installation Advisor (the install executable at 
the root of the Support Pack) to install the Cross-Platform client. Instead, you can run the install 
executable located in /client/linux or you can install the novell-groupwise-gwclient-6.5.3 RPM 
located in the same directory.

6.2.2  Cross-Platform Client Performance

For best performance, run the Cross-Platform client in Caching mode. It is noticeably faster than 
Online mode.
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6.2.3  Running as root in Caching Mode

If you run the Cross-Platform client in Caching mode as root on Linux, you might encounter 
synchronization problems with your master mailbox when you next run as a regular user. If 
pending requests from the root session remain when you log in as a regular user, regular user 
requests get backed up behind the root requests, which cannot be processed while you are logged 
in as a regular user. To resolve any problems, run the client as root again so that all messages get 
synchronized, then run as a regular user thereafter to prevent further problems.

6.2.4  HTML Message Display

Some HTML-formatted messages are not rendered correctly in the Cross-Platform client.

6.2.5  Some Settings Not Saved

In Online mode, custom column sort settings are not saved unless the Cross-Platform client is 
connected to a GroupWise 6.5 for Linux POA or later. The problem will be resolved for NetWare 
and Windows POAs in a future Support Pack.

6.2.6  “Not Accepting Jobs” Print Error

This is a Java* error. A newer version of the JVM* resolves it. The print jobs print successfully in 
spite of the error message.

6.2.7  Mailbox Size Limits Not Recognized

The Cross-Platform client does not recognize the mailbox size limits set in ConsoleOne (Tools > 
GroupWise Utilities > Client Options > Send > Disk Space Management).

6.2.8  Bold Not Displaying on Macintosh

If you have installed Microsoft Office or Internet Explorer on your Macintosh*, new messages 
might not display as bold in your mailbox. To resolve the problem, disable your user fonts, which 
are typically duplicates of your system fonts, or update to JVM 1.4.2 Update 1 or later.

6.2.9  Unavailable Client Features

The GroupWise Cross-Platform client does not currently provide some functionality that is 
available in the GroupWise Windows client, including:

Spell checking

Rules

Categories

Viewers for attachments

Remote mode to support modem connections

S/MIME (encryption and digital signatures)

Document management

Additional functionality will be available in future releases of the Cross-Platform client.
11
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7.0  Internet Agent Issues

7.1  General Internet Agent Issues

7.1.1  Address Resolution Change Since GroupWise 6

In GroupWise 6 and its Support Packs, there was a problem with the address format used for 
sending to distribution lists and resources if you set Internet Addressing to one of the following 
formats (which are not appropriate for distribution lists and resources):

first_name.last_name@Internet_domain

last_name.first_name@Internet_domain

Messages to distribution lists and resources were initially undeliverable and were sent to the 
Internet Agent. The Internet Agent then successfully resolved the addresses and sent the messages 
back into the GroupWise system. Users did not notice the problem, but some administrators 
noticed unnecessary traffic through the Internet Agent.

In GroupWise 6.5, the address format problem for sending to distribution lists and resources was 
corrected. However, users who originally used GroupWise 6 have the erroneous address format 
for distribution lists and resources in their Frequent Contacts address books. If unnecessary traffic 
through the Internet Agent is a continuing problem, have users delete distribution lists and 
resources from their Frequent Contacts address books so that the correct address format is used for 
name completion in the future.

7.2  NetWare/Windows Internet Agent Issues
None.

7.3  Linux Internet Agent Issues

7.3.1  Installation Security

During installation, the Internet Agent Installation program requires access to eDirectory by way 
of LDAP authentication. The LDAP Group object includes an option named Require TLS for 
Simple Binds with Password, which is enabled by default. With this option enabled, you must 
provide the LDAP server’s Trusted Root Certificate, which must be exported from the LDAP 
server, in order for LDAP authentication to take place (typically on port 636) during installation 
of the Internet Agent.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple 
Binds with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear 
text (typically on port 389), during installation of the Internet Agent. After disabling the option, 
restart eDirectory, install the Internet Agent, then re-enable Require TLS for Simple Binds with 
Password and restart eDirectory again.

7.3.2  libXm.so.3 Error

If you try to start the Internet Agent on a server where The X Window System and OpenMotif are 
not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory
12   
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To resolve the error, start The X Window System and OpenMotif before starting the Internet Agent 
with the --show switch. If you start the Internet Agent without the --show switch, you can use the 
Internet Agent Web console to monitor the Internet Agent from your Web browser.

8.0  WebAccess Issues

8.1  General WebAccess Issues

8.1.1  Login Page Reappears after Successful Login

If the WebAccess login page appears in one or more of the frames (for example, the Folder list or 
the Item list) after a WebAccess user has successfully logged in, the user is probably accessing 
WebAccess through one or more proxy servers.

To prevent this problem:

1 In ConsoleOne, right-click the WebAccess Application object (GroupWiseWebAccess), then 
click Properties.

2 On the Security page (located on the Application tab), deselect the Use Client IP in Securing 
Sessions option. 

For information about this option, click Help on the Environment page.

3 Click OK to save the change.

8.1.2  Recommendation for Tomcat Memory Allocation (Heap Size)

If you are using the Tomcat servlet engine with GroupWise WebAccess, the maximum memory 
allocation (heap size) for Tomcat should be at least 128 MB. The maximum memory allocation is 
set by using the -Xmx parameter when starting Tomcat (for example, -Xmx128m).

8.2  NetWare/Windows WebAccess Issues

8.2.1  Using the Latest Novell Client

If you receive an error during installation indicating that the nvweb.dll file cannot be found, update 
the workstation to the latest Novell Client. The Novell Client is available for download from the 
Novell Software Downloads site (http://www.novell.com/download).

8.2.2  Display Problems with Netscape 4.x

If you experience display problems using Netscape* 4.x with WebAccess, update to a later version 
of Netscape.

8.2.3  Security Issue with WebAccess and Internet Explorer 5.0

When using Internet Explorer 5.0 to view messages through WebAccess, URLs to messages 
become part of the History cache and can be read by other users who have access to the same 
workstation. For solutions to this problem, see TID 10056452 in the Novell Knowledgebase (http:/
/support.novell.com/search/kb_index.htm).
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8.3  Linux WebAccess Issues

8.3.1  Novell Distribution of Apache and Tomcat

GroupWise 6.5 for Linux includes a Novell distribution of Apache and Tomcat that you can install 
along with the WebAccess Application if you do not already have Apache and Tomcat running on 
that server. The Novell distribution is installed in the following directories:

Apache: /var/opt/novell/http and /etc/opt/novell/http
Tomcat: /var/opt/novell/tomcat4 and /etc/opt/novell/tomcat4

and is started using the following customized commands:

Tomcat: /etc/init.d/novell-tomcat4 start
Apache: /etc/init.d/novell-httpd start

The WebAccess Installation program lets you choose whether you want to install the Novell 
distribution. During installation, select Install WebAccess Application with Apache and Tomcat 
if you want to install the Novell distribution. Select Install WebAccess Application if you do not 
want to install the Novell distribution of Apache and Tomcat because you have an existing Apache 
and Tomcat installation that you want to use with WebAccess.

If you install the Novell distribution on a server where a standard distribution of Apache and 
Tomcat is already installed and running, you will encounter a port conflict on port 80. You can 
resolve the port conflict by choosing to run one distribution or the other, or you can reconfigure 
one distribution or the other.

To reconfigure the Novell distribution to use a different port number, edit the httpd.conf file in the 
/etc/opt/novell/httpd/conf directory. Locate the following line:

Listen 80

Change the port number to a something that is not already being used on the server, then save and 
exit the file.

8.3.2  Prolonged “Please Wait” Message during Installation

On slower machines, if you select Install WebAccess Application with Apache and Tomcat, your 
machine might appear to hang on the “Please Wait” message. Apache and Tomcat are being 
installed while the “Please Wait” message is displayed, before the WebAccess Application 
installation begins.

8.3.3  Installation Security

During installation, the WebAccess Installation program requires access to eDirectory by way of 
LDAP authentication. The LDAP Group object includes an option named Require TLS for Simple 
Binds with Password, which is enabled by default. With this option enabled, you must provide the 
LDAP server’s Trusted Root Certificate, which must be exported from the LDAP server, in order 
for LDAP authentication to take place (typically on port 636) during installation of the 
WebAccess.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple 
Binds with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear 
text (typically on port 389), during installation of WebAccess. After disabling the option, restart 
eDirectory, install WebAccess, then re-enable Require TLS for Simple Binds with Password and 
restart eDirectory again.
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8.3.4  Re-installation Issue

If you install WebAccess in an eDirectory context where the WebAccess objects already exist, a 
message informs you that you can “use the existing objects.” In actuality, the objects are deleted 
and re-created, so if you have customized the properties of the existing objects, you must 
customize the objects again after installing WebAccess. 

8.3.5  New WebAccess URLs

Existing users of the WebAccess are accustomed to accessing the following URLs:

Web Services page: Default index.html file of the Web server
WebAccess: http://web_server_address/servlet/webacc
WebPublisher: http://web_server_address/servlet/webpub

On Linux, use the following URLs:

GroupWise-specific Web Services page: http://web_server_address/gw/index.html
WebAccess: http://web_server_address/gw/webacc
WebPublisher: http://web_server_address/gw/webpub

As an added benefit, GroupWise 6.5 for Linux configures SSL for you, so that the following URLs 
provide SSL security without additional configuration on your part:

GroupWise-specific Web Services page: https://web_server_address/gw/index.html
WebAccess: https://web_server_address/gw/webacc
WebPublisher: https://web_server_address/gw/webpub

8.3.6  WebPublisher Configuration

The WebAccess Installation program does not configure WebPublisher for you. Some manual 
configuration is required. For instructions, see the GroupWise 6.5 Installation Guide (/docs/us/
GroupWiseInstallationGuide.pdf).

8.3.7  WebPublisher Template Settings Not Saved

Changes to the settings on the Templates page of the GroupWiseWebPublisher object in 
ConsoleOne are not saved to the webpub.cfg file. To work around this, after making changes on 
the Templates page, select a different property page on the GroupWiseWebPublisher object, then 
click OK or Apply to save the template settings correctly.

8.3.8  Commented Lines in Configuration Files

If you have commented out any lines in the WebAccess configuration file (webacc.cfg) or the 
WebPublisher configuration file (webpub.cfg), you should back up those files before installing 
Support Pack 3. If you use the Configure WebAccess Application option in the Installation 
program, those commented lines become uncommented and the settings return to their defaults. 
However, any other changes you have made to the configuration files are retained. You must 
comment out the lines again and edit the settings as needed, using the backup copies for reference.
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9.0  Monitor Issues

9.1  General Monitor Issues

9.1.1  Restoring Monitor Settings after Reinstallation

Monitor settings are stored in the monitor.xml file in the Monitor installation directory. If you 
reinstall the Monitor software, the monitor.xml file is backed up as monitor.001. To restore 
previous Monitor settings, remove the newly installed monitor.xml file and rename monitor.001 
to monitor.xml.

9.2  Windows Monitor Issues
None.

9.3  Linux Monitor Issues

9.3.1  Monitor Issues Shared with WebAccess

Monitor and WebAccess share a substantial amount of functionality. The following WebAccess 
issues pertain to Monitor as well:

Novell Distribution of Apache and Tomcat
Prolonged “Please Wait” Message during Installation
Installation Security
Re-installation Issue

9.3.2  New Monitor URLs

If you’ve used Monitor on Windows, you are used accustomed to accessing the following URLs:

Web Services page: Default index.html file of Web server
Monitor Web Console: http://web_server_address/servlet/gwmonitor

On Linux, use the following URLs:

GroupWise-specific Web Services page: http://web_server_address/gw/index.html
Monitor Web Console: http://web_server_address/gwmon/gwmonitor

9.3.3  Problem Starting Monitor on Red Hat 3 AS

If you encounter problems starting the Monitor Agent on Red Hat 3 AS, set the LC_ALL 
environment variable using one of the following commands:

export LC_ALL=C
export LC_ALL=POSIX
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10.0  International Issues

10.1  General International Issues

10.1.1  Double-Byte Characters in Directory Names and Filenames

Do not use double-byte characters in directory names and filenames.

10.1.2  Double-Byte Characters in Passwords

Do not use double-byte character in users’ passwords. 

The Change GroupWise Password dialog box in ConsoleOne currently allows entry of double-
byte characters. However, the GroupWise client login does not allow entry of double-byte 
characters in passwords, so a user who was assigned a password with double-byte characters in 
ConsoleOne cannot type the double-byte characters when attempting to log in to GroupWise.

10.1.3  Euro Character in Subject Field

If a WebAccess client user receives a message, task, or appointment with a Euro character in the 
Subject field, it might display as an upside-down question mark when viewed in the Java version 
of the Calendar. The issue resides with the user’s browser.

Netscape users need to upgrade to Netscape Communicator* 6.

Internet Explorer users need to be using at least version 3309 of the JVM. The latest JVM can be 
downloaded from the Microsoft Web site and installed on the user’s workstation. This JVM 
enables Internet Explorer 4.x and later to correctly display the Euro character.

10.1.4  Unicode Support in WebAccess

Unicode* support using UTF-8 encoding has been implemented in WebAccess to provide better 
support for international character sets. Unicode support enables users to intermix characters 
within the same message and have all character sets display correctly.

For Support Pack 3, Unicode support is not fully implemented for double-byte character set 
languages (DBCS languages). In order to correctly compose in a DBCS language, users need to 
set their browser accept language to the desired DBCS language. Also in Support Pack 3, 
intermixing two different DBCS languages is not supported. These limitations will be removed in 
the next major release of WebAccess.

If you will update to Support Pack 3 in stages, update the WebAccess Agent first throughout your 
system, then update the WebAccess Application. If the update to Unicode support causes 
undesirable side effects for your particular language or combination of languages, you can turn it 
off using the /utf8off startup switch with the WebAccess Agent. Then comment out the 
Charset.default setting in the webacc.cfg and webpub.cfg files. This procedure will not be 
necessary after Unicode support is fully supported for DBCS languages.

10.1.5  Character Encoding in WebAccess

Auto-detection of character encoding for the WebAccess/WebPublisher index.html page does not 
work for some Web browsers. If you do not see the localized languages in the drop-down menu 
on the Web services page (index.html), set your browser’s character encoding to UTF-8 (for 
example, click View > Encoding).
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You might also encounter character encoding problems when reading HTML-formatted messages. 
In this case, set your browser’s character encoding for the new message window to UTF-8. You 
can do this by right-clicking in the message and then setting the encoding or using View > 
Encoding.

10.1.6  Help Display in Japanese WebAccess

If you click Help in the Japanese WebAccess client, the help text does not display properly. To 
correct the problem, edit the \apache2\conf\httpd.conf file and comment out the following lines:

ForceLanguagePriorityPreferFallback
AddDefaultCharset

Then restart Apache.

10.2  NetWare/Windows International Issues

10.2.1  Print Calendar Language

The GroupWise client Print Calendar feature always prints calendars in the language specified in 
Regional Options or Regional Settings in the Control Panel, even if the client is installed in a 
different language. For example, if French (Switzerland) or French (Swiss) is specified in the 
Control Panel and the client is installed in German, calendars print in French.

10.2.2  RichWin and GroupWise 6.5

If you use RichWin in combination with GroupWise 6.5, be sure to run RichWin first, then run 
GroupWise.

10.3  Linux International Issues

10.3.1  Display Problem with Agent Console Interfaces

If you run the agents with an agent console interface in languages other than English, the display 
of logging information might not display correctly. The problem occurs if your language encoding 
is set to UTF-8.

To determine your current language encoding, use the following command in a terminal window:

locale

You can change your language encoding in YaST:

1 Start YaST, click System, then double-click Choose Language.

2 Select the language you are running the agents in, then click Details.

3 Deselect Use UTF-8 Encoding, then click OK.

4 Stop and then restart the agents to put the new setting into effect.

10.3.2  Extended Characters in Attachment Filenames

If you are using the WebAccess client in the Konqueror browser, you cannot attach files that have 
names including accented characters. Konqueror does not send the filenames back in UTF-8 
format.
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10.3.3  Russian Keyboard

When you use a Russian keyboard, the Linux environment variables that provide language and 
locale information are typically set to ru_RU. Typically, this setting implies the Russian character 
set ISO-8859-5. However, on some distributions of Linux, the ISO-8859-5 character set must be 
set explicitly in order for your Russian keyboard to work with the GroupWise Cross-Platform 
client. Use the following command to specify the character set along with the language and locale 
information:

export LANG=ru_RU.ISO-8859-5

In most cases, setting the LANG environment variable also sets all LC_* environment variables 
and resolves all Russian keyboard problems. If you set the LANG environment variable and your 
Russian keyboard still does not work, use the following command to view the current settings for 
the LANG and LC_* environment variables:

locale

If any of the LC_* environment variables have not inherited the ISO-8859-5 specification, export 
them individually.

10.3.4  Mnemonics for Arabic, Hebrew, and Double-Byte Languages

Keyboard mnemonics for menu items work for characters a-z and A-Z, but not for other characters.

10.3.5  Localized Agent User Interface Display

The Linux GroupWise agent user interfaces display correctly if the Linux environment is using the 
ISO-8859-1 character set, which is the default for the GroupWise administration languages and 
locales.

French: fr_FR
German: de_DE
Portuguese: pt_BR
Spanish: es_ES

If the Linux environment is using a different character set encoding such as UTF-8 (for example, 
fr_FR.UTF-8), the localized agent user interfaces do not display correctly.

11.0  Documentation Issues

11.1  General Documentation Issues
None.

11.2  NetWare Windows Documentation Issues

11.2.1  GroupWise 6.5 Help

To support accessibility requirements within GroupWise Help, the Help for all GroupWise 
components uses Microsoft HTML Help. In order for Microsoft HTML Help to display on a 
Windows workstation, the workstation must have Internet Explorer 4.x or later installed.
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11.3  Linux Documentation Issues

11.3.1  Right-to-Left Text in Cross-Platform Client Help

Languages that display right-to-left display right-justified rather than left-justified.

11.3.2  Web Link in ConsoleOne Help

The link from the ConsoleOne help to the Novell GroupWise documentation Web site does not 
work. This problem will be addressed in a future version of ConsoleOne. In the meantime, you can 
copy the URL from the ConsoleOne help topic into your browser window in order to access the 
GroupWise documentation Web site.

11.3.3  Help Image Display on an iChain Server

If you display help from an agent Web console on a server where Novell iChain® is installed, and 
if iChain is configured to use the Path-Based Multihoming option, the image at the top of the help 
topic does not display.

12.0  Defect Fixes

12.1  Address Book Fixes
Name completion works correctly for a user in your Frequent Contacts address book whose 
e-mail address has been stored in firstname.lastname format.

You can always cut and paste all types of addresses from one message to another successfully.

If you send a message from the GroupWise Address Book to an external user, the first and last 
names are included in the e-mail address when the user is subject to an Internet addressing 
override of “First Name.Last Name@Internet domain name.”

Organization entries in a personal address book retain the contents of all fields.

Fixed an Address Book crash.

12.2  Administration Fixes
Schema extensions for GroupWise 6.5 Support Pack 3 are compatible with both GroupWise 
6.5 Support Pack 2 and GroupWise 6.5 for Linux Support Pack 2.

If you create a user in a post office in a secondary domain while connected to the secondary 
domain, the distinguished name is now replicated to the post office database.

Scheduled events created in secondary domains are synchronized throughout your 
GroupWise system.

If you move a user from the primary domain to a secondary domain, all information on the 
User object property pages is moved.

You can move a distribution list from one secondary domain to another while connected to 
the primary domain.

The Validate Domain option of System Maintenance checks for duplicate records in the 
domain database. Rebuilding the domain database removes the duplicate records.
20   



    Novell Confidential                                                                                            Manual (ENU)  6 October 2004
If you lock Client Options, and Caching mode users download the settings, and if you then 
unlock the settings, the unlocked settings are synchronized down to the Caching mailboxes.

When you delete a remote document storage area, its location is completely deleted from the 
guardian database, which prevents problems if the post office is ever moved to a different 
server.

A domain with a very long name (for example, more than 30 characters) can be updated from 
GroupWise 5.5 to 6.5.

In a multiple tree system, you are no longer prompted to log into additional trees when you 
access the Link Configuration Tool with a secondary domain in a different tree selected.

You can use the Tab key to move through the fields on an External User object.

If you move a post office from NetWare or Windows to Linux, uppercase/lowercase issues 
are handled appropriately so that the databases on Linux are created correctly.

DBCopy transfers databases from NetWare to Linux more successfully.

Fixed a DBCopy abend on NetWare.

12.3  Admin API Fixes
None.

12.4  Agent Fixes
The Linux POA can now handle software updates for Windows clients.

The POA honors the IP address specified by the /ip switch in the startup file for all ports 
(HTTP, IMAP, LDAP, and so on).

The POA picks up changes in the HTTP User Name and HTTP Password fields on the Agent 
Settings page of the POA object in eDirectory so that you don’t have the restart the POA after 
making these changes in ConsoleOne.

When you turn on administrator error mail in ConsoleOne, the POA sends error mail to the 
selected administrative users.

In the POA Web console, multiple IMAP sessions from the same IP address are listed 
separately.

In the POA Web console, the number of client/server users listed on the Status page is 
accurate.

In the POA Web console, the redirection table can display IP addresses, proxy addresses, or 
both.

The POA no longer checks CPU utilization under certain circumstances where the CPU 
utilization information was erroneously causing the POA to delay move user processes.

The POA returns only valid TCP/IP addresses and ports for redirection and to the client. 

In a post office with multiple POAs, you can configure one POA with just an internal IP 
address to handle internal redirection and another POA with just a proxy address to handle 
external redirection.

When an IMAP client accesses the POA with an SSL connection, the stability of the 
connection has been improved.
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The new /imapreadlimit switch allows you to set the number of messages to be download to 
an IMAP client.

The redirection IP address is now listed in the POA log file.

The Linux POA can provide auto-update capabilities for the Windows client software from a 
software distribution directory on Linux.

After a post office has been moved from NetWare to Linux using DBCopy, the Linux POA 
can successfully access the databases and log users into their mailboxes.

If a post office that has a remote document storage area is moved from NetWare or Windows 
to Linux, and if you forget to provide the correct storage area location in the Linux Path field, 
you can still get the Linux POA to start by using the --noconfig switch so that the POA ignores 
the missing document storage area.

Fixed several POA abends.

The MTA handles document references correctly.

Routing errors no longer stop the MTA from processing messages in the post office queues.

The SNMP page of the MTA Web console now includes MtaDomainName.

Fixed several MTA abends.

12.5  Client Fixes (Windows)
In order to identify external recipients, e-mail addresses are appended to display names for 
external recipients.

If you select the font for message text by right-clicking on the Desktop and then clicking 
Properties > Appearance > Message Text, GroupWise uses your selected font permanently.

If you have your default Read View set to HTML, you can view a text attachment and then 
return to the HTML view of the message.

If Force Plain Text View is enabled and you manually choose to view an HTML-formatted 
message, the message window redisplays correctly.

When you open the Calendar in a separate window, you can drag and drop messages into the 
Reminder Notes section of the calendar.

When you create a new contact in the Address Book, you must provide a display name.

If you print labels from the Address Book, letters that descend below the line of print are not 
truncated.

Messages in shared folders can be forwarded as attachments.

If a folder with a large number of messages is shared, all the messages are downloaded into 
Caching mailboxes of users with whom the folder is shared.

An attachment with a comma (,) in the filename can be saved successfully using File > Save 
As.

In the Checklist folder or in any folder set to display as a checklist, pressing the Alt key, Ctrl 
key, Windows key, or Application key plus a letter no longer creates a spurious checklist 
entry.

The Phone Message view file is copied to the correct location.

Items are eligible for archiving if they have been marked Read, even if they have never been 
opened.
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Busy Search does not crash the client if it encounters bad data.

When proxied into another user’s mailbox with rights to modify options, rules, and folders, 
you can modify the proxy rights of another user in the proxy list.

A rule-generated reply that includes recipients in the BC field retains the users in the BC field.

Reply rules work on messages originating in a different e-mail system but with the same 
Internet domain name.

If you move a document in shared folder to another library, the document reference is 
successfully updated.

PDF attachments that are encrypted in base64 and that are attached to Internet messages can 
be opened successfully in the GroupWise client.

The QuickViewer does not crash the client if you click View in an empty folder.

After you import a certificate into GroupWise, an unnecessary security warning no longer 
appears when you open a digitally signed message.

The GroupWise client reliably checks the Certification Revocation List (CRL).

Searches in document lookup tables work correctly.

The Hit the Road feature continues downloading items to your Remote mailbox even if 
unreadable view records are encountered.

SetupIP uses proper HTTP transmission termination coding with resolves a problem 
transmitting the Windows client software through a firewall.

When you receive a message containing TNEF text originating in a Microsoft product, the text 
is not cut off when displayed.

To resolve an issue introduced in Windows XP Service Pack 2, GroupWise and Notify are 
automatically added to the firewall exception list during installation.

If you use the mailto action in an HTML file on a link that includes a distribution list, the link 
functions correctly after the Address Book has been opened.

On Windows XP, if you use the mailto action in an HTML file to call the GroupWise client 
and provide a text string for the Subject field, the Subject field is filled in successfully when 
the message is generated and sent.

When using an Entrust* ESP 7 server with a Datakey USB token device for storing 
certificates, the certificates appear in the My Certificates dialog box in GroupWise. 

In Open Office, you can use File > Send > Document as EMail to start the GroupWise client.

With LDAP authentication enabled, you can change your GroupWise password when it 
includes extended characters.

All Japanese characters in the JIS 0208 1997 standard display correctly.

In the Japanese client, extraneous spaces no longer occur between characters in the Subject 
line.

With the Windows environment set to either Hebrew or Arabic, the MIME message header is 
created with the correct character set.

In the Hebrew client, mouse focus is now accurate and Calendar icons no longer disappear.

In the Hebrew client, you can open the Calendar folder when there is an unaccepted 
appointment in the Mailbox folder.
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In the Hebrew and Arabic clients, if you enter an incorrect password, the resulting dialog box 
is properly formatted.

12.6  Client Fixes (Windows; Section 508 Accessibility)
When composing a message in HTML format, the formatting features available on the HTML 
toolbar are also available under Edit > Format so that they can be accessed by keystrokes.

On the Send Options tab of a message, the screen reader identifies the spin boxes under the 
Reply Requested, Expiration Date, and Delay Delivery options. If Reply Requested is 
deselected, the focus skips the radio buttons.

On the Send Options tab of a message, you can select a category from the drop-down list by 
typing the category name and pressing the Spacebar. The screen reader reads the setting of the 
check box.

The new Message Status column displays text to convey the meaning indicated by icons. The 
screen reader can read the text and thus provide status information about the item.

You can always use the Esc key to close an opened e-mail message.

In an opened e-mail message, you can use the Right-arrow and Left-arrow keys to move the 
focus from tab to tab (Mail, Properties, Personalize) in the Mail From window.

A screen reader reads all of a distribution list, even if it extends beyond the length of the To 
field.

On the Send Options tab of a new mail message, you can set the Delay Delivery options and 
then tab onward to the next field.

You can use the Tab key to navigate through the prompt that occurs if you want to open an 
attachment that is larger that the size specified in Warn If Larger Than under Tools > Options 
> Environment > Default Actions.

When you move the focus to the first attachment, the screen reader indicates “1 of n” to 
indicate how many attachments there are.

You can attach a desktop shortcut file to a message by using keystrokes.

When viewing a message, if you open the Print dialog box and then close it again, the focus 
is still on the message you are viewing.

When the focus is on the drop-down list of modes (Online, Caching, and so on), the list can 
be expanded by pressing Enter.

With the QuickViewer open and the focus on Calendar in the Folder List, you can tab to the 
various parts of the Calendar, for example, Appointments, Notes, and Tasks.

In the Calendar, you can use keystrokes to navigate to View > Go to Date and change the day. 
Also, you can see that pressing Tab moves the focus to the next field.

In the Calendar, you can move the focus to each hour.

In the Calendar, you can move the focus to the subject of each appointment.

You can change the Calendar view (Day, Week, Month, and so on) using View > Change 
Calendar View.

You can use the Right-arrow and Left-arrow keys to move through the Tasks and Notes areas 
of the Calendar. If a task or note is present, the screen reader reads the subject line.

In the Calendar’s Multi-User List dialog box, the Address Book button, the Up Arrow button, 
and the Down Arrow button can be read by a screen reader.
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In the Multi-User Setup dialog box for printing a Multi-User Calendar, the Up Arrow and 
Down Arrow buttons can be read by a screen reader.

In the Calendar and the Go to Date dialog box, a screen reader reads the date as soon as the 
focus moves into the Calendar or dialog box.

In the Print Calendar dialog box, you can navigate to the Franklin Sizes radio button.

When you do a Busy Search using Tools > Busy Search, the focus is initially and obviously 
in the To field in the Busy Search dialog box.

The Choose Appointment Time dialog box, accessed by clicking Busy Search in a new 
appointment, has improved for readability by a screen reader. For example, the focus is 
initially and obviously in the Available Times Grid. Pressing the Down-arrow key to move 
the focus in the Available Time Grid does not adjust the appointment length. Pressing the 
Spacebar selects or deselects recipients in the Recipient List. The calendar name is read when 
you tab through the Available Times tab fields and the Individual Schedules time fields. 
Information in the Desired Time box, as well as Out of Office, Busy, and Tentative schedule 
markings, are read by the screen reader. Existing appointments are read. By default, the 
Available Times tab is displayed, rather than the Individual Schedules tab. 

During a Busy Search, the screen reader includes the status of the search each time an arrow 
key is pressed for any other focus movement in the Busy Search dialog box.

In the Go to Date dialog box, the date is highlighted to indicate the initial location of the focus.

In the Go to Date dialog box, the buttons for moving forward and backward by days, weeks, 
months, and years now have names that can be read by a screen reader.

In a posted appointment, the screen reader correctly reads the Start Date and Time fields.

In the Notebook view of the Calendar, pressing Tab no longer moves the Notebook view into 
the background.

In the text view of the Calendar, if you tab to a posted appointment and delete it, the 
confirmation prompt allows you to successfully cancel the deletion. In addition, you can now 
use Alt+Delete to delete a selected posted item.

In the text view of the Calendar, duration time is included with appointment information.

In the text view of the Calendar, seconds are no longer displayed as part of the appointment 
time.

If you select High Contrast Black as a custom color scheme under Accessibility Options in 
the Control Panel, the Calendar displays white text on a black background.

In the Date Difference dialog box, the arrow buttons have unique names indicating whether 
they are in the Start Date or End Date box.

In the list of address books, pressing the Down-arrow and Up-arrow keys moves the focus 
from one address book to the next. Pressing Tab moves the focus into the selected address 
book.

You can use Tab and Shift+Tab to navigate through the options in the Novell GroupWise 
Address Book.

You can use Tab and Shift+Tab to navigate through the options in the Novell LDAP Address 
Book.

In the New Contact dialog box, pressing Ctrl+Tab moves the focus from tab to tab (Summary, 
Contact, Office, and so on).
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In the Frequent Contacts Properties dialog box, a screen reader correctly reads the button to 
the right of the Name field as “Address Book button”.

In the Frequent Contacts Properties dialog box, you can move the focus to an individual name 
and set access properties for it.

In the New Contact dialog box in Frequent Contacts, mnemonics are now unique. Fax has 
been changed to Alt+X. Mobile has been changed to Alt+B. Prefix has been changed to 
Alt+R.

On the Office tab of the New Contact dialog box in Frequent Contacts, mnemonics are now 
unique. Country has been changed to Alt+U.

On the Personal tab of the New Contact dialog box in Frequent Contacts, mnemonics are now 
unique. Country has been changed to Alt+U. Also, you can move the focus to the Birthday 
field. 

In the New Organization dialog box in Frequent Contacts, mnemonics are now unique. 
Country has been changed to Alt+U and Primary Contact has been changed to Alt+R.

In the Create Personal Folder dialog box, a screen reader correctly reads “1 or 5” for the five 
radio buttons and you can tab successfully through all the options in the dialog box.

In the Checklist folder, you can use the Tab key to navigate through the fields of an item.

In the Checklist folder, you can select Due On and provide a date.

In the Checklist folder, you can mark an item completed by moving the focus to the item in 
the Checklist and pressing the Spacebar.

In any folder displayed as a checklist, you can open a checklist item, then press Esc to close it.

In any folder displayed as a checklist, the screen reader identifies the Due On field even if no 
date is specified.

In the Documents folder, the screen reader reads the information for each document after 
reading the column under which the information is listed, for example, Name, Subject, 
Modified, and so on.

In the Document Properties dialog box of a document in the Checklist folder, you can tab to 
the Move to Top and Move to Bottom buttons and activate the buttons by pressing Enter.

In the Select Columns dialog box, available from the Display tab of the Properties dialog box 
of the Documents folder, you can continue tabbing after using the Down or Up button to 
change the location of a column in the list.

In the Document Properties dialog box, you can tab to the Document Type button on the 
Document tab.

The Document tab of the Document Properties dialog box now has Alt keys for options and 
fields.

On the Sharing tab of the Document Properties dialog box, the rights fields have unique 
names.

In the Version Level Security dialog box available from the Sharing tab of the Document 
Properties dialog box, the rights fields have unique names.

When selecting a date in the Date Created field of the Find by Example dialog box, the buttons 
in the Date Input dialog box have readable names.

When you create a Find Results folder, the focus remains with the folder after you use the 
Advanced Find button to set up search criteria.
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To set header properties (header color, text color, font size) on a folder, move the focus to the 
folder icon and its name, then press Shift+Down-arrow to display the drop-down list of header 
properties.

In the Tools > Options dialog box, you can press the Spacebar to activate an option 
(Environment, Send, Documents, and so on).

In the Tools > Options > Date & Time dialog box, the abbreviated days of the week in the 
Month Display Option box and the Work Schedule box are pronounced by the screen reader 
so there is no ambiguity between days that start with the same letter.

In the Rules dialog box, you can use the new Move Up and Move Down buttons to reorder 
the rules.

In the New Rule dialog box, if you select an event type of Filed Item, Open Folder, or Close 
Folder, you can tab to the Select Folder button.

In the Junk Mail Handling dialog box, on the Junk List tab, you can create new items in the 
Address/Domain list. Then, after closing and reopening the Junk Mail Handling dialog box, 
you can tab to the items you have added to the list.

In the Junk Mail Handling Dialog box, on the Junk List, Block List, and Trust List tabs, you 
can tab to the Addresses and Domains options. You can also delete items in the Address/
Domain list and then continue tabbing.

In the Filter dialog box, you can tab to the Address Selector buttons in the From and To, CC 
fields.

In the Advanced Filter dialog box, if you select a field to filter on that includes a number in 
the filter criteria, you can move the focus to the number, then press the Up-arrow or Down-
arrow key to increase or decrease the number.

In the Advanced Filter dialog box, if you select Category, you can then select a category from 
the drop-down list by typing the category name and pressing the Spacebar.

12.7  Client Fixes (Cross-Platform)
HTML messages are never truncated and the reply separator text is added correctly.

The check box and envelope icon for items in the Checklist folder line up properly.

If you use the Tab key to move from the To field to the Subject field and then back to the To 
field, you can edit the contents of the To field.

The Macintosh Cross-Platform client is more stable.

12.8  Client API Fixes
When the Client API forwards or replies to a message, the appropriate bit is set in the current 
message so that the GroupWise client displays the appropriate icon.

The Client API filters out Address Book entries where Visibility is set to None.

Third-party programs can set the Peek Mode flag so that items downloaded to a PDA are 
marked Downloaded, rather than Opened and Read. 

The put_Opened() or put_Read() methods return status information back to the sender of the 
message.

The ItemSetPriority, PrefAdvanced, and PosToEndOfText tokens work correctly.

The QuickMessages collection no longer finds Hidden (non-visible) messages. 
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The QuickMessages collection correctly returns tasks for a specified date.

The QuickMessages collection no longer hangs when running multiple threads for multiple 
GroupWise accounts.

The Start Date field has been added to the QuickMessage object to facilitate processing 
Calendars with large numbers of appointments.

You can create personal appointments in an AutoDate group.

The Client API no longer hangs when attempting to retrieve an appointment from a damaged 
database.

The AutodateMessages property returns a warning if a returned object (Appointment, Task, 
or Note) is not a recurring item.

Trusted Applications can see Hidden (non-visible) System Address Book entries.

The Folders collection object can be refreshed so that any changes to the Folders, especially 
by other programs, are reflected in the collection. 

The Recipients collections includes BCC users on messages from external users.

The Address object always returns the correct e-mail address and display name.

When accessing an AddressBookEntriesFields collection, each Field object has the correct 
value.

When accessing an AddressBookEntriesFields collection, SaveValue stores additional fields.

The AddressBookEntriesFields collection gives the Last Modification time as “Date 
Hour:Minute:Seconds.”

The AddressBookEntries collection allows the addition of an Organization object.

The Birthday text field can be found in an AddressBookEntriesFields collection.

The following AddressBookEntry fields can now be updated: Home Address, Home City, 
Home State, Home Zip, Home Country, and Office Web Site.

The process of adding an Organization to an AddressBookEntry has been speeded up.

Using Message.AddExistingMessage no longer causes a runtime error.

Using Message.Clone includes a draft message’s category properties.

Calling Message::Reply, then Message::Send no longer causes the original recipient to 
receive two replies.

The plain text or RTF properties of a message can be accessed consistently.

The Query.Locations filter works properly.

The AddressBookEntries::Item() method handles display names that consist of three names, 
rather than just first name and last name.

The AddressBookEntries::Find() method no longer displays hidden entries.

Passing an Address object as the Variant parameter when calling the 
AddressBookEntries::Item() method returns a valid AddressBookEntry object.

When calling the AddressBookEntries::Find() method with a search filter using the PABGuid 
field, asterisk (*) and question mark (?) are not treated as wildcard characters.

The Messages::Add() method of the Messages collection creates a Posted (Personal) message.
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The AddExisitingMessage() method of the Messages collection successfully adds a Personal 
(Posted) message to the Mailbox. 

The value of AttachmentControl.CurrentAttach is always set correctly for each attachment.

The value of CategoryDefinitions.Count is set correctly to 0 (zero) when there are no 
categories.

Mail.DelayedDeliveryDate works correctly so that delayed delivery messages are delivered 
at the correct time.

Setting the Mail.DelayedDeliveryDate property no longer causes the client to crash in 
Caching Mode.

The new AccountUID property returns different information for Online, Caching, and Remote 
mailboxes. For an online connection, it returns the e-mail address of the account. For a 
Caching or Remote connection, it returns the e-mail address with a unique number appended 
to it.

The ClassName property has been added to the QuickMessage object.

The PeekMode flag in MultiLogin no longer sets the Read flag.

A runtime error no longer occurs when using Message.Send after using Message.Forward.

Accessing the Recipients collection no longer causes a Windows system registry error.

Using the Recipients.Add method, CC and BC recipients are no longer placed in the To field.

The gwoapi6.h header file now includes all necessary properties, including BoxType and 
ClassName that were missing in the previous version of the file.

The GUID returned from a System Address Book Entry -> Fields collection (in Non-MAPI 
mode) is now the proper length (36 bytes). 

The FormattedText object correctly returns the Unicode version of all text characters. 

12.9  Engine Fixes
The performance of the IMAP fetch command has been improved.

The IMAP fetch command handles offsets and partial reads correctly.

Performance of the IMAP status command has been improved.

Blind Copy recipients are no longer lost from the header of IMAP messages.

IMAP processing has been improved when attachment filenames contain character set 
definitions.

The Importance and X-Priority fields have been added to the IMAP header.

If a message from an IMAP client includes ISO-8859-2 characters (Eastern Europe character 
set), and if the client does not indicate how to encode the characters, then encoding defaults 
to UTF-8.

IMAP no longer erroneously associates distribution lists with personal items.

A JavaMail* application can successfully add a message to the Sent Items folder using IMAP.

The date and time formats in appointments for external CAP client users are correct.

CAP clients can modify the DESCRIPTION iCalendar property, which is the message body 
of the calendar item.
29



    Novell Confidential                                                                                            Manual (ENU)  6 October 2004
If the text of a posted appointment is modified by a CAP client, the Windows client displays 
the updated text.

The CAP logic handles the STATUS property.

CAP processing has been improved.

12.10  GWCheck Fixes
The standalone version of GroupWise Check runs successfully against a large number of 
users.

The forceclean Support option cleans up databases beyond what the standard Expire/Reduce 
action accomplishes.

The proxyfix Support option has been improved to remove invalid access records that could 
not previously be removed.

The totals listed in the GWCheck log file for expired items is accurate.

The Auto Delete function cleans up items that are Marked as Read but not Opened.

Error messages generated during library checking that are not critical and that cannot be fixed 
are suppressed.

12.11  Internet Agent Fixes
The Internet Agent creates a correct Reply To address if the e-mail address of the sending 
Internet user includes a middle initial. 

The Internet Agent handles messages that contain pound signs (#) in the addresses.

When messages are sent to external users, the Internet Agent returns status information 
successfully. 

If you override a user’s default IDomain and provide a free-form address for the user, the 
Internet Agent assembles the correct e-mail address for the message.

The new /keepsendgroups startup switch prevents the Internet Agent from expanding 
distribution lists on messages going to external Internet users so that the SMTP header does 
not become too large.

The new /dontreplaceunderscore startup switch prevents the Internet Agent from replacing 
underscores (_) in usernames with spaces.

The new /imapreadlimit startup switch allows you to set the maximum number of messages 
to be download to an IMAP client.

In the gwia.cfg file created during installation, the /mailview startup switch is correctly set to 
Internet. If it is set to anything else, the Junk Mail Handling feature of the GroupWise 
Windows client does not correctly identify incoming mail from the Internet and does not 
process it successfully.

When setting up access control, if you want to set up an exception to allow messages where 
the username is blank, you can put Blank-Sender-User-ID in the Allow Messages From list 
on the Class of Service page under Access Control on the Internet Agent object in 
ConsoleOne.

The Internet Agent handles SSL connections more efficiently.
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The Internet Agent can receive messages with MIME boundaries larger than 72 characters, 
even though RFC 2046 states that 70 characters should be the maximum MIME boundary 
length.

The Internet Agent correctly processes messages with a base64 encoded message body.

When the content-ID in the header of a message is more then 70 characters, the attachment no 
longer gets renamed to the first character that overflowed 70-character limit of the content-ID.

The Internet Agent does not issue a 5xx-level connection error until after the RCPT TO: 
command, which makes the functionality parallel to Postfix and Sendmail.

When you receive a message with the From address in the format 
"Last,First"<flast@company.com> and reply to it, the Reply To address no longer loses the 
first character of the first name.

The Internet Agent no longer loses one character of pager messages.

The Internet Agent provides a settings page in XML format as well as HTML format.

The Mime Encoding field is always preserved so that international characters display 
correctly. 

NetWare and Windows Internet Agent log files are now named mmddgwia.nnn instead of 
mmddlog.nnn so that it is obvious that they pertain to the Internet Agent. The Linux Internet 
Agent already uses this naming convention.

The Internet Agent console logs POP and IMAP SSL sessions along with other types of 
sessions.

Fixed several Internet Agent abends.

12.12  Monitor Fixes
When updating Monitor, the Monitor Installation program deletes legacy Monitor servlet files 
that are not needed in the new version.

If Monitor has been configured to support a proxy service, links to GroupWise agents display 
agent status information through a firewall.

The Monitor’s java.cfg file has bee updated so that the latest XML parser is in the class path, 
resolving “The page cannot be displayed” errors.

The Linux Monitor Agent can send notification e-mail messages successfully through an 
SMTP relay server.

12.13  WebAccess Fixes
The WebAccess Installation program correctly looks for Apache on NetWare 6.5 in the /
apache2 directory, rather than /apache.

The WebAccess client no longer displays a C045 error when you open an Internet message 
that has recipients in the To field that are not part of your GroupWise system.

Very large attachments are saved completely.

The variables used to display disk space limits are set correctly so that accurate disk space 
usage can be displayed in the WebAccess client.

The Spell Checker now works with JRE version 1.4.2.04.

In the Japanese WebAccess client, the Japanese yen symbol displays correctly.
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Fixed several WebAccess abends.

13.0  Additional Documentation
In addition to this Support Pack Installation Readme (readmeus.txt), the following sources give 
information about the Support Pack:

For a list of known issues, see gw65_iss.txt located at the root of the Support Pack.
NOTE: The Readmes available when installing components from the GroupWise Installation program are 
the original GroupWise 6.5 Readmes. They do not contain Support Pack issues.

For the latest GroupWise 6.5 documentation, see the GroupWise 6.5 Documentation Web site 
(http://www.novell.com/documentation/gw65). It has been updated to correspond to 
GroupWise 6.5 Support Pack 3.

For information on the latest Support Pack issues, see the GroupWise 6.5 Support Pack 3 
Readme Addendum (http://support.novell.com/cgi-bin/search/searchtid.cgi?/10093964.htm).

14.0  Documentation Conventions
In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark; an asterisk (*) denotes a third-party 
trademark.

15.0  Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity 
of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.

You may not use, export, or re-export this product in violation of any applicable laws or 
regulations including, without limitation, U.S. export regulations or the laws of the country in 
which you reside.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is 
described in this document. In particular, and without limitation, these intellectual property rights 
may include one or more of the U.S. patents listed at http://www.novell.com/company/legal/
patents/ and one or more additional patents or pending patent applications in the U.S. and in other 
countries.

Copyright © 2004 Novell, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the 
publisher.
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ConsoleOne, GroupWise, NetWare, and Novell are registered trademarks of Novell, Inc. in the 
United States and other countries.

NLM is a trademark of Novell, Inc.
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